Preparing for Lab 8
 Building Home Pages for the World Wide Web
A web page is a text file stored in a UNIX directory called html. This directory is placed inside the public directory. Any files created during this lab are to be stored in this directory. If you do not have an html directory complete the following steps:

1. Use Telnet to connect to the UNIX-based computer.

2. Change to the public directory.

Check to see if the html directory already exists by using the “ls”. See Figure 3. If this directory does not exist go to step 3, otherwise start Lab 4.
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Figure 3: Listing of the public directory before creating the html directory

3. Create the “html” directory by using the “mkdir” UNIX command. See Figure 4.

Type the following command at the $ prompt:

mkdir html
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Figure 4: Creating html directory in public

Make sure the html directory has been created properly. See Figure 5.
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Figure 5: The html directory in public is listed after being created
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4. Change to this new directory. See Figure 5. Use the “pwd” command to verify that you are actually in the “html” directory. See Figure 6.

Figure 6: Using the “pwd” command to verify that the working directory is “html”

Lab 8
Building a Personal Home Page
PRIVATE 
Purpose
The purpose of this lab is to construct a personal home page. In the process, we learn the language of the Web — Hyper Text Markup Language or HTML. 

Background
A web page is an HTML document composed of ordinary text. A web page is created with a text editor like Pico or any word processor like Microsoft Word as long as the document is saved as a text file. An example of an HTML document is shown below in Figure 1.
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<HTML>

<TITLE>The Document Title</TITLE>

<H1>The Level 1 Heading</H1>

  My first Web document.

  This sentence ends the first paragraph.<P>

  The second paragraph in this Web document ends

  on this line. <P>

</HTML>

Figure 1: A simple HTML document

This document consists of ordinary text interspersed with special symbols of the form <some_text> called markup tags. Each markup tag instructs the web browser how to display a portion of the document on the computer's screen. See the last three pages of this lab for an explanation of some of the basic markup tags.

Procedure
1.
Use Notepad to create a file called welcome.htm. This file contains the text below (Figure 2). Begin entering the text replacing any text_in_italic-bold with the requested information as shown in Figure 3.


<HTML>

<TITLE>your_name Home Page</TITLE>

<CENTER>

<H1> your_name </H1>

<H2> Major: your_major_field_of_study </H2>
<H3> EMail: your_email_address </H3>
 </CENTER>

   Type a short paragraph of information about you.  For example, I am a 

   Junior at the University of Pittsburgh.  I plan to study in London, England 

   during the first six-week summer session.  Upon returning in June, I will 

   work as an intern at Alcoa in Pittsburgh. 

  <P>

   Type a second paragraph of information about you.
  <P>

</HTML>


Figure 2: Web page sample to be included in the file welcome.htm
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<TITLE>Laura Duval Home Page</TITLE>
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Figure 3:  Creating an HTML file with Notepad
2.
In Notepad, Save this file as welcome.htm and store it on your floppy disk. Be sure to type the extension of the file name as (.htm). See Figure 4.  Close Notepad after saving the file.
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Figure 4: Saving the HTML file as welcome.htm
3. 
Open My Computer and locate the HTML file welcome.htm. See Figure 5.
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Figure 5: Locating welcome.htm

· Double-click on the file to start the default web browser (Internet Explorer or Netscape) and load the welcome.htm.  Do you see the home page? See Figure 6.
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Figure 6: Welcome.htm loaded in the web browser
4. Viewing document HTML source
To see the source document (the HTML file) of a web page, choose View | Source (in Internet Explorer) or View | Document Source (in Netscape). Try this now. See Figures 7.a and 7.b.
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Figure 7.a: Viewing an HTML document source in Netscape
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Figure 7.b: Viewing/loading an HTML document source in Internet Explorer
5.a) Add a colored background:

The sample web page has a colored background. It is has a greenish tint. Use the "View" menu then "Source" to find the command line beginning with the words “BODY BGCOLOR.” It follows the TITLE line (see Figure 8). This command is used to display a background color.

[image: image10.png]welcome. htm - Notepad

e Edt Fomat Vew Help

<HmeL>
<TITLE>Laura Duval Home Page</TITLE>

<CENTER>
<H1> Laura Duval </HL>
<H2> Major: Music </H2>





Figure 8: HTML tag for background colors
· Add the following background color to the Web page:

<BODY   BGCOLOR=”FAFAEC”    TEXT=“500AAA”>
· Save the Web page in Notepad, then switch to the Web Browser’s window and click the Refresh button to reload the web page. Do you see the new background color? 

· Every time you make changes to the Notepad file, save it, and then reload it in the Web browser.  
The BGCOLOR tag allows you to select a color for the page background, and the TEXT tag allows you to change the color of the text on the page. The colors shown with these attributes (#D39AC2 and #500AAA) are called hexadecimal numbers which correspond to specific colors interpreted by the browser. The list below shows some hexadecimal colors which could be used instead of the two colors shown in the BODY tag:

White

#FFFFFF


Yellow

#E7EBB4

Off White
#FAFAEC


Light Gray
#E1E5E2

Taupe

#F0D9C1


Warm Gray
#CDC0C0

Tan

#DFC3A6


Black

#000000

Light Green
#BEE3C2

Note: The newer versions of Web browsers do not require the # sign in front of the hexadecimal numbers, therefore they can be omitted. However, a simpler way is to use the name of a color rather than the hexadecimal code to specify it. For example: red, yellow, lightyellow, green, lightgreen, white, blue, etc. 

· Experiment with various background colors, hexadicaml or others, including the following color (choose your own colors. Be Creative!). 
<BODY BGCOLOR=“yellow”  TEXT=“blue”>

5.b) Including an image as web page background:

To include an image as a background on the web page, use the form:

<BODY BACKGROUND=”image-name-goes-here”  TEXT=”red”>

The background image fills the web browser’s window with multiple copies of the image. The TEXT attribute is specified within the same BODY tag.

Do this step only if you wish to include an image as a background on the web page, otherwise skip to 5.c.

5.c) Return to Notepad and carry out the following steps:

1) Add a background color to welcome.htm (place it after the TITLE line). Do not forget to save this file. See Figure 9.
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Figure 9: Adding the background line to your home page

2) Return to the web browser, click the Reload (Netscape) or Refresh (Internet Explorer) buttons to reload the web page. Do you see a colored background?

3) Choose any of the colors listed above or experiment with the six-digit hexadecimal number to create a different background color. After editing welcome.htm, save it. 

Suppose the changes made in welcome.htm do not appear on the web page. Clear the cache in Internet Explorer. To do this, select "Internet Options" from the "Tools" menu and click Delete Files. 

The Delete Files dialog box will appear as shown in Figure 10. Check the box for “Delete all offline content” then click the OK button. This will clear disk cache and its related memory, which will allow the web page to be reloaded and reflect the changes made to it. 
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Figure 10:  Clearing the Cash - delete all offline files in Internet Explorer
6. Read about other markup tags at the end of this section. Edit “welcome.htm” to experiment with other markup tags. In particular, add an example of each of the markup tags described below. This step is designed to help you learn HTML. 


a) Create a numbered list (also called an ordered list) <OL>, this list contains my favorite authors (or a list of your choice – be creative). Create your own list. See Figure 11.





1. G. Flaubert





2. J. Austen





3. W. Collins





4. P.D. James





5. I. Asimov


b) Create a definition list <DL> where each item is italicized and where each definition is printed in the default font (choose your own definitions or use the ones listed below). For example, 


telnet

The telnet command allows you to connect and log in to a remote computer

ftp

The ftp command allows you to retrieve files that are publicly available from another computer on the Internet.


pine

The pine command allows you to send mail to other computer users on the Internet. See Figure 11.
c) Create a nesting of unordered lists <UL>, the one shows information about states (or preferably use your own choice).




A few New England states:





Vermont





New Hampshire





Maine




Two west-coast states:





California





Oregon


 Figure 11: HTML document “welcome.htm” including Order list<OL>, Definition list <DL>, 

Unordered list <UL>, and two reference links 

In the next several steps, we learn how to link a home page to another document in the html directory. Usually, a home page consists of more than one page. One page is linked to another by clicking on hypertext (underlined text usually appearing as blue) that activates a linked page.

Creating a file that is linked to your home page

7. With Notepad create a file called courses.htm then save it on your floppy disk. See Figure 12.


<HTML>


<TITLE>Fall Schedule</TITLE>


<H1>Courses 99-1</H1>


Make an unordered list of all courses you are registered for this term.

</HTML>
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Figure 12: Creating another html document, courses.htm
Be sure courses.htm file is saved in the same folder as welcome.htm. 

Adding a hyperlink within your home page

Hyperlinks (also called reference links) can be made to local HTML files (stored in the html directory) or to remote Web sites (the full URL is needed).  In the next two steps, we create two hyperlinks: one to a local file and the other to a remote Web site.

8. Create a Hyperlink to the local html file courses.htm. Add the following lines at the end of the file “welcome.htm”:



Click to view:



<A HREF = "courses.htm">Schedule of Courses</A>

Don't forget to save this file!  See Figure 11.

Return to the web browser then scroll to the end of your home page. Do you see the text below?








Click to view: <BR>




Schedule of Courses

9. Create a Hyperlink to the remote Web site http://www.cnn.com (or choose a favorite link).  Add the following lines at the end of the file “welcome.htm”:




<BR>



<A HREF = "http://www.cnn.com"> CNN link </A>

Save this file.  See Figure 11. 

Return to the web browser then scroll to the end of your home page. Do you see the text below?

Click to view:
Schedule of Courses
CNN Link
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Figure 13: Two reference links to “courses.htm” and “http://www.cnn.com”

Double click the “Schedule of Courses”. Do you see the course schedule in the courses.htm?
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Figure 14: courses.htm Web page
Double click the “CNN link”. Do you see CNN’s web page? 
Placing a graphic image in your home page

10. Copy the image “pittlogo.gif” from the class directory or upload it from the CD.

 
Place the logo in the web page by adding this tag after your e-mail address:

<IMG SRC=“pittlogo.gif”   align=middle>

After saving this file, reload your web page. Do you see the logo?  

Saving/downloading an image from a web page

11. When browsing the web, to save and obtain a copy of an image from any web page, do the following steps:

a) Click with right mouse button on the image. 

b) Save it to your diskette with the same or different name.

12. Viewing the Web page welcome.htm within the Internet
The files you created in this lab are local to your computer. In order to view them within the Internet (or remotely), they must be stored on a Web server. Your UNIXs account resides on the UNIX computer which is equivalent to a web server.  
· Using FTP, transfer the files: welcome.htm, courses.htm, and pittlogo.gif to your UNIXs account, and store them in the html directory that is inside public (~/public/html). 
· Your URL to view your home web page remotely with the http protocol is:
http://www.pitt.edu/~yourusername
· Load your home page remotely with the http protocol. Do you see it? If not, make sure your transfer the files into the html directory of your unix account. 
Congratulations, you are now part of Cyberspace

12. Lab Summary

This lab includes the following steps:

1. Create a directory called “html” in your “public” directory.

2. Create a simple Web page called “welcome.htm” with Notepad text editor.

Several enhancements will be made to the page:

3. Add a background color or image

4.
Add several lists:

a. Ordered list

b. Definition list

c. Unordered list

5. Create another page called “courses.html” within the html directory

6. Add two hyperlinks (reference links) to:

a. Local file, courses.html

b. Remote web site, http://www.cnn.com, or your own link.

7.  Add a graphical image

Lab 8
Building Your First Home Page
(IV.1: Home Web - 1)  
Activity Sheet
Name_____________________________________

    


Score_________

    








Total = 20 points

Email______________________________________


Directions: Place this sheet on top of all completed activities and staple them.  Number any printed documents with the activity number listed below.  Hand in all completed activities at the end of the lab period to your lab instructor.  Point value shown after each activity.

1. Print a copy of each Web page (displayed on the screen ),




a) from welcome.htm, Figure 13


(3)




b) from courses.htm, Figure 14


(2)

by using Print from the File menu within your web browser.

2.  Hand in a printed copy of the source files showing the HTML tags for,




a) welcome.htm, Figure 11


(3)




b) courses.htm, Figure 12



(2)

Hint: Use the View/Source option within the web browser and Print 

from the File menu.

HTML Markup Tags

HTML

To delimit text in an HTML document use <HTML> to mark the beginning and </HTML> to mark the end of a document.

Title

Every HTML document should have a title.  A title is generally displayed separately from the document and is used primarily for document identification.



<TITLE>Enter the title of your document here</TITLE>

Headings

HTML has six levels of headings, numbered 1 through 6, with 1 being displayed in the most prominent way (bold and larger fonts).  You can use the <Hi> more than once.



<H1>Enter first heading here</H1>



<H2>Enter second heading here</H2>





...



<H6>Enter sixth heading here</H6>

Paragraphs

Unlike word processing documents, carriage returns in an HTML document are not significant.  Word wrapping can appear at any point, and multiple spaces are collapsed to a single space.  To mark the end of a paragraph use <P>, after the paragraph has been typed. This paragraph is followed by a blank line when displayed.

Line Breaks

The tag <BR> causes a line break.  Unlike <P> where a blank line is generated, <BR> simply starts a new line of text.

Anchor

The chief power of HTML comes from its ability to link regions of text and images to other documents.  Netscape highlights these regions (usually with colors and/or underlines) to indicate a hyperlink.



<A HREF = "filename">name_of_hyperlink</A>

where name_of_hyperlink is the text in your document indicating the hyperlink to the file "filename".

Unnumbered lists

An unnumbered list is a listing of items, one item per line.  The tag <UL> indicates the start of an unordered list and </UL> indicates the end of an unordered list.  Each item in the list is marked with <LI> (use I not 1).  For example,


<UL>



<LI> item1 



<LI> item2 




...



<LI> itemN 


</UL>
The output is




item1




item2




  ...




itemN
Ordered lists

Ordered (numbered) lists are displayed one item per line preceded with its number.  <OL> marks the beginning of an ordered list and </OL> marks the end of an ordered list.  Each item is marked with the <LI> tag (note:LI is el-eye not el-one).  For example,


<OL>



<LI> item1



<LI> item2




...



<LI> itemN


</OL>

The output is




1. item1




2. item2




    ...




N. itemN
Definition lists

A definition list usually consists of alternating a term (abbreviated as DT) and definition (abbreviated as DD).  Web browsers usually format the definition on a new line.  For example,



<DL>




<DT> term1





<DD> definition1




<DT> term2





<DD> definition2





   ...




<DT> termN





<DD> definitionN



</DL>

The output is




term1





definition1




term2





definition2





...




termN





definitionN
Nested lists

Lists can be arbitrarily nested.  For example,



<UL>




<LI> item1





<UL>






<LI> item1.1






<LI> item1.2






...






<LI> item1.M





</UL>




<LI> item2





<UL>






<LI> item2.1






<LI> item2.2






...






<LI> item2.N





</UL>



</UL>
The output is





item1






item1.1






item1.2





  
 ...






item1.M





item2






item2.1






item2.2





  
 ...






item2.N

Bold

To bold text, use <B> to mark the beginning and </B> to bold the text.  

For example,




<B>This text is in bold!</B>

The output is




This text is in bold!
Italic

To italicize text, use <I> to mark the beginning and </I> to end the italicize the text.  For example,




<I>This text is in italics!</I>

The output is




This text is in italics!

Preformatted text <PRE> …. </PRE>

If you have an existing text (or a text file) that includes spaces, indentation, blank lines, etc. You can keep the preformatted text as it is by using the <PRE> … </PRE> tags. For example,




<PRE>



This      is my     preformatted  t    ext
I  just saw a tab






This is the second line with a few more tabs



</PRE>

The output is



This      is my     preformatted  t    ext
I  just saw a tab






This is the second line with a few more tabs

Don’t add this line





Don’t add this line





Don’t add this line








Add the background line here
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